JMP Menu

Item

About JMP Pro...

U.S. Government
Notice

Preferences...

Services
Hide JMP
Hide Others
Show All

Quit JMP

File Menu

Item

New

Open...

Open Recent

Open Multiple...
Close

Close Multiple...

Save

Save As...

Revert to Saved

Close Project

JMP 17 macOS Menu Descriptions

Description

Shows the product version, registration, user and system information, the JMP web page link,
and more. (Pro is displayed in the menu item when you are using JMP Pro.)

Shows the U.S Government restricted rights notice.

Enables you to edit settings for start-up items, reports, tables, analysis platforms, import and
export settings, graphic formats, fonts, SAS integration, and more. Also enables you to restore
the defaults.

Shows available macOS services.

Removes the JMP application from view.

Removes all other applications from view, leaving only JMP visible.
Brings all open applications into view.

Closes all JIMP windows and quits JMP. Prompts you to save new or changed JMP files. Also
asks whether you want to save the session script.

Description

Creates a new data table, script, journal, database query, project, application, dashboard, add-in
or workflow.

Locates and opens files of different types.

Lists the most recently opened files. The Clear Menu command at the bottom of the list enables
you to clear the list.

Opens multiple files from a folder, combining similar files into data tables.
Closes the active window. Prompts you to save changes.

Enables you to choose which open windows to close. Prompts you to review the modified
documents.

Writes the active window to a file with the appropriate extension. Press Ctrl and select Save
Selection As to save the highlighted portion of an analysis window in a graphic format. Press
Ctrl and Option and then select Save All to save the content in all open JMP windows.

Writes the active window to a file after prompting you for a file name and folder.
Restores the current JMP file to its last saved condition.

Closes the current project. Available only when a project is open.



File Menu (Continued)

Item

Save Project

Save Project As...

Export...

Publish...

Database

SAS

Internet Open...

Page Setup...

Print...

Save Session Script...

Edit Menu

Item
Undo
Redo

Cut

Copy

Copy With Column
Names

Description
Saves the current project. Available only when a project is unsaved.
Saves the current project using the specified name. Available only when a project is open.

Exports data to text, JSON data, Microsoft Excel, Google Sheets, SAS data set, or SAS Transport
file formats. Exports reports into text, images, HTML, interactive HTML with dynamic graphics,
RTF, and Microsoft PowerPoint formats. Exports a JMP application source file as an application
that runs when opened in JMP, or exports the JMP application as a JSL file. The available options
are based on the type of file that you are exporting.

Publishes the current reports to a web page. You can publish to JMP Live, JMP Public, or to an
interactive HTML web report. You can also publish data to JMP Live. Use the Manage
Connections option to add new JMP Live connections.

Opens the Query Builder for interactively building SQL queries; opens a connection to any
database on your system that has an ODBC driver; opens or saves a data table; or imports a
database from an OSlsoft PI Server.

Connects to a SAS server; enables you to browse and run SAS® Stored Processes or open SAS
data files and folders; opens the SAS Query Builder for interactively building SQL queries;
provides an editor window; sends SAS code from JMP to the currently active SAS server; opens
SAS Log and Output windows; and exports data to SAS.

Opens remote files in a browser or text editor window, and opens an HTML table as a data
table. Enables you to open JMP data tables and run scripts from a URL. Also provides a way to
open data as a Google Sheets spreadsheet.

Displays the standard window for setting printed page properties.
Prints the active window.

Creates a JMP Scripting Language (JSL) script to re-open all currently open files and re-run all
currently open analyses and graphs.

Description
Cancels the effect of the most recent reversible Edit, Rows, or Columns command.
Reverses the most recent Undo command.

Copies selected data table cells to the clipboard and replaces the data with missing values. In
reports and other windows, copies selected content to the clipboard.

Copies selected data table cells to the clipboard. In reports and other windows, copies selected
content to the clipboard.

Copies selected data table cells and column names to the clipboard. The data table must be
active.



Edit Menu (Continued)

Item

Copy As Text

Copy With Full
Precision

Paste

Paste With Column
Names

Delete

Select All

Search
Reformat Script
Go To Line...

Balance

Comment Block
Uncomment Block
Shift Right

Shift Left

Encrypt Script...

Decrypt Script...

Import as Data

Run Script

Stop Script

Debug Script

Description

Selects items from the panels of the data table window, such as with the columns and rows
panels. It does not require the use of the fat plus sign selection tool. When you select one or
more items from the panels, the Copy As Text menu item is available.

Copies a column of numeric data and maintain the full precision. Applies only to the fixed
decimal format. The data table must be active and the Ctrl key pressed when the Edit Menu is
clicked.

Copies content from the clipboard into the open window.

Copies data from the clipboard into the active data table. Converts text on the first line of the
clipboard to column names.

Removes selected data table cell contents and adds missing values. In journal and script
windows, removes selected content.

Selects all rows in a data table. In reports and other windows, selects all content when one item
is selected.

Finds and replaces text in data tables and scripts.
Adds tab and return characters where appropriate to reformat a script.
Scrolls to a specific line number in a script.

Selects all text within a pair of brackets that include the cursor. Available only if a script window
is active.

Comments the selected block in the JSL script.

Uncomments the selected commented block in the JSL script.
Shifts selected lines in a script to the right.

Shifts selected lines in a script to the left.

Places encoding in a script so that you must have the password to open or run the script.
Available only if an unencrypted script is in the active window.

Enables you to open or run an encrypted script. Available only if an encrypted script is in the
active window.

Imports text-formatted data using the Import Settings in JMP > Preferences > Text Data Files.
Before selecting the Import as Data command, you must paste the data into the active script
window.

Processes JSL commands entered in the script window. You are prompted to select a data table,
if none are opened. If several data tables are opened, the script is run on the last table that you
opened. Otherwise, the script is run on the only open table. When a script is being run, this
option changes to Stop Script.

Stops the script running in the active window. When a script is not running, this option changes
to Run Script.

Enables you to troubleshoot script errors in the JSL Debugger.



Edit Menu (Continued)

Item
Submit to SAS

Journal

Lock Journal

Start Dictation...

Emoji & Symbols

Tables Menu

Item

Summary

Subset

Sort

Stack

Split

Transpose

Join

Update

Concatenate

JMP Query Builder
Missing Data Pattern

Compare Data Tables

Anonymize

Description
Connects to a specified SAS server and submits SAS code directly from JMP.

Copies output from a data table or report window to a journal window. Enables you to save
reports, add notes, and organize output.

Prevents you from editing the journal. The command changes to Unlock Journal when the
journal is already locked.

Allows you to dictate text anywhere you can type it.

Allows you to enter emoji, symbols, accented letters, and characters from other languages.

Description

Creates a table that contains user-specified summary statistics calculated from the active
data table.

Creates a new data table that is a subset of the active data table and can be linked to the original
data table.

Sorts a JMP data table by one or more columns. This creates a new data table, or you can replace
the original table with the sorted table.

Stacks selected columns into one or more new columns in a new data table.

Splits one or more columns, according to values in a Split By column, to form multiple columns
in a new data table.

Creates a new data table in which the data in the selected columns of the original table are
arranged in rows. Transposing equates to switching the rows and columns in the original
selection.

Adds columns from a second table to the main table, using row number or matching columns,
or by forming a Cartesian join.

Replaces data in the active table with data from a second table without producing a new table.
Stacks two or more tables on top of each other by matching column names.

Interactively queries one or more data tables to create a new data table.

Describes the missing data in your table in terms of the columns where it is missing.

Compares the numbers of columns and rows, table properties and scripts, column attributes
and properties, and data in two open data tables.

Removes unique identifiers from the data table or selected columns.



Rows Menu

Item

Hide and Exclude
Exclude/Unexclude
Hide/Unhide
Label/Unlabel
Colors

Markers

Next Selected
Previous Selected
Row Selection
Clear Row States

Clear Selected Row
States

Color or Mark by
Column...

Row Editor

Delete Rows
Add Rows...
Move Rows...

Data Filter

Cols Menu

Item
New Columns...
Column Selection

Reorder Columns

Column Info...

Description

Hides and excludes selected rows in plots and analyses.

Excludes or includes selected rows in analyses.

Hides or shows selected points in all plots.

Labels or unlabels selected points in all plots.

Changes selected points in all plots to a selected color.

Replaces selected points in all plots with symbols that you select.

Locates and flashes the first selected row in a data table after the current row.
Locates and flashes the first selected row in a data table before the current row.
Provides several options for selecting rows based on one or more conditions.
Clears all active row states in the data table.

Clears all selected row states in the data table.

Assigns colors or markers to rows based on values in a selected column.

Opens a window that enables you to edit cells in a row. Helps you select rows and create new
rows.

Removes all selected rows from the data table.
Adds rows to a specified location in the data table.
Moves selected rows to a specified location in the data table.

Selects, shows, or includes rows based on conditions on the values of selected columns.

Description
Adds a new column, and enables you to name the column and change attributes and properties.

Highlights and scrolls to the specified column. Locates and flashes the first or next selected
column in a data table after the current column. Selects any column that is currently deselected
and deselects any column that is currently selected.

Moves the selected column to the selected location. Rearranges columns by the original order,
name, data type, modeling type, or in reverse order.

Shows the column properties and enables you to change the column name, attributes, and
properties for selected column or columns.



Cols Menu (Continued)

Item

Standardize
Attributes...

Preselect Role

Formula...

Label/Unlabel

Scroll Lock/Unlock

Hide/Unhide

Exclude/Unexclude
Use for Marker
Recode...

Columns Viewer

Utilities

Column Names

Clear Cell Colors

Group Columns

Ungroup Columns

Delete Columns

Description

Sets attributes and properties for multiple columns at once.

Assigns an analysis role, which can be saved with the data table, to selected column or columns.
Shows the formula editor window for selected column or columns.

Tells JMP whether to use values from the selected column or columns to identify points in plots
when the cursor is placed near them. To display labels for points on plots, the corresponding
rows must have a label row state.

Locks or unlocks selected columns into or from the left-most position in the table. Locking a
column keeps its contents visible when you scroll horizontally.

Hides or shows selected columns without removing them from the table. Retains them in
analyses.

Excludes or includes selected columns in analyses.
Displays the images in expression columns as markers on graphs.
Enables you to edit and group cell values for the selected column.

Provides a quick way to view columns using specific criteria (such as column names, properties,
and attributes). You can then view summary statistics and properties for those columns, view
quartiles in the summary statistics, show the columns in a separate data table, and more.

Restructures data. Compresses columns, converts a column of delimited data to multiple
columns, creates indicator columns, combines columns, customizes binned data, converts a
numeric column of codes to value labels, converts a column of strings to numeric codes, and
recodes column names. New Column by Text Matching uses a regular expression to parse a
column of text.

Move Up moves the first row of data to the column heading row. Move Up and Append
appends the first row of data to the column names. Move Down moves the column headings to
the first row of data. Recode Names opens a recode window that provides recode options for
column names.

Clears the color of selected colored data table cells.

Groups columns under one heading to manage large numbers of columns and facilitate analysis
role assignment. Grouped columns are shown in outline view under a gray disclosure icon in
the columns panel.

Removes the grouping heading and displays individual column names in column panel and
analyses.

Removes selected columns from the data table.



DOE Menu

Item
Custom Design

Augment Design
Easy DOE
Definitive

Screening

Classical

Design Diagnostics

Consumer Studies

Description
Creates D-optimal and I-optimal designs for a wide range of design situations and constraints.

Adds runs to an existing design in an optimal fashion. Provides different choices for how to add
these runs.

Provides a platform for designing, running, saving, analyzing, predicting, and documenting the
results of a designed experiment.

* Definitive Screening Design creates a design with three levels for every quantitative factor.
Main effects are independent of two-factor interactions, and two-factor interactions are not
confounded with each other.

* Fit Definitive Screening provides options for modeling definitive screening designs.

¢ Screening Design constructs classical and main effects screening designs. The factors can be
2-level continuous, discrete numeric, and categorical factors with an arbitrary number of
levels.

* Fit Two Level Screening provides options for modeling screening designs.

* Response Surface Design generates a list of classical response surface designs for the specified
number of continuous factors and creates the chosen design.

¢ Full Factorial Design creates a design using all combinations of factor levels for a set of
continuous and categorical factors with an arbitrary number of levels.

¢ Mixture Design creates a design that is appropriate when the factors are components in a
mixture. Some design types accommodate linear constraints.

¢ Taguchi Arrays constructs a Taguchi design. Signal and noise factors, a choice of inner and
outer array designs, and signal-to-noise ratios are supported.

* Evaluate Designs evaluates designs for any table treated as a design. You can modify the
model terms and the aliasing terms, and the diagnostics update accordingly.

* Compare Designs compares two or three designs simultaneously to explore and evaluate their
performance. Provides diagnostics that show how the designs perform relative to each other
as well as how they perform in an absolute sense.

* Sample Size and Power computes power, sample size, and effect size for means, variance,
proportions, and counts. The platform also computes sigma quality level and more.

¢ Choice Design creates an optimal discrete choice conjoint experimental design. These designs
are useful in studies where users are asked to specify preferences relative to combinations of
product or service features.

* MaxDiff Design constructs a design consisting of choice sets that can be presented to
respondents as part of a study where respondents specify most and least preferred
combinations of features.



DOE Menu (Continued)

ltem Description

Special Purpose e Covering Array creates a design for testing systems where failures occur as a result of
interactions among components or subsystems (JMP Pro).

¢ Space Filling Design creates a design that is appropriate when modeling deterministic or
nearly deterministic systems, such as computer simulations.

® Accelerated Life Test Design constructs tests based on one or two accelerating factors with
either a main effects model or an interaction model for the latter.

* Nonlinear Design creates an optimal design for estimating the parameters of a nonlinear
model.

e Balanced Incomplete Block Design creates a design for testing a treatments in b blocks where
only k treatments (k < a) can be run in any one block.

* MSA Design generates a full factorial design for a measurement systems analysis (MSA)
experiment and provides design diagnostic measures.

* Group Orthogonal Supersaturated Design creates a supersaturated design where the factors
are partitioned into k orthogonal groups, with k =2 or a multiple of 4.

¢ Fit Group Orthogonal Supersaturated provides options for modeling a group orthogonal
supersaturated design.

Sample Size Enables you to investigate the impact of sample size on your ability to answer specific questions
Explorers when planning experiments or studies.

Analyze Menu

ltem Description

Distribution Provides a histogram for continuous data and a bar chart for nominal or ordinal data, along with
relevant summary statistics. Presents options for many one-sample analyses, based on modeling
type.

FitY by X Shows plots that describe the relationship between any two variables. Provides two-sample

analyses based on the modeling types of the two variables, such as bivariate, one way, logistic, and
contingency analysis.

Tabulate Constructs tables of descriptive statistics using an interactive interface.

Text Explorer Analyzes pieces of unstructured text, such as comment fields in surveys or incident reports,
enabling you to interact with the text data with tools to consolidate similar terms, recode
misspecified terms, and gain understanding of the underlying patterns in your textual data.
(Analytics are available in JMP Pro.)

Fit Model Fits models involving one or more Y variables and multiple X variables. Techniques include
standard least squares, stepwise, generalized regression (JMP Pro), mixed models (JMP Pro),
generalized linear mixed models (JMP Pro), MANOVA, loglinear variance, logistic, proportional
hazards, parametric survival, generalized linear models, partial least squares (JMP Pro), and
response screening.



Analyze Menu (Continued)

Item

Predictive
Modeling

Specialized
Modeling

Screening

Multivariate
Methods

Clustering

Quality and Process

Reliability and
Survival

Consumer Research

Description

Offers predictive modeling techniques: neural, partition analysis, bootstrap forest (JMP Pro),
boosted tree (JMP Pro), K nearest neighbors (JMP Pro), naive Bayes (JMP Pro), support vector
machines (JMP Pro), model screening (JMP Pro), and model comparison (JMP Pro). The menu
also provides options to make validation columns and access prediction models that you saved in
the Formula Depot (JMP Pro).

Offers specialized modeling techniques: nonlinear, functional data exploration, Gaussian process,
time series, time series forecast, and matched pairs.

Offers techniques for screening large data sets, including analyzing outliers and missing values.

* Explore Outliers enables you to explore outliers in both the univariate and multivariate cases.
* Explore Missing Values enables you to explore and impute missing values in your data.
e Explore Patterns enables you to explore and find unusual features or patterns in your data.

* Response Screening automates the process of conducting tests across a large number of
responses.

* Predictor Screening is useful in screening a data set for significant predictors.

* Association Analysis analyzes transaction (market basket) data to identify items that appear
together in transactions (JMP Pro).

* Process History Explorer analyzes complex processes to identify where a defect has occurred.

Offers techniques for exploring relationships among multiple variables: multivariate fitting,
principal components, discriminant analysis, partial least squares, multiple correspondence
analysis, structural equation models (JMP Pro), factor analysis, multidimensional scaling,
multivariate embedding, and item analysis.

Offers techniques for clustering: hierarchical clustering, K means clustering, normal mixture
clustering, clustering rows based on categorical variables using multinomial mixtures (latent class
analysis), and clustering variables into groups of highly correlated variables.

Offers techniques for evaluating quality-related issues in processes or products: control charts
(including an interactive control chart builder), CUSUM control charts, EWMA control charts,
model-driven multivariate control charts, legacy control charts, process screening, process
capability analysis (including capability for non-normal process measurements), measurement
systems analysis, variability and attribute gauge charts, Pareto plots, and fishbone (Ishikawa
Cause and Effect) diagrams. You can also manage specification limits. Other options include
managing specification limits and creating a graph of Operating Characteristic Curves (OC
Curves).

Offers techniques for fitting survival and reliability data: life distribution, fit life by x, cumulative
damage, recurrence analysis, degradation, repeated measures degradation, destructive
degradation, reliability growth and forecasting, reliability block diagrams (JMP Pro), repairable
systems simulation (JMP Pro), product-limit survival fit, parametric survival distributions, and
proportional hazards modeling.

Offers techniques for studying consumer preferences. Options include categorical response
survey analysis, choice models, MaxDiff analysis, uplift models for identifying the positive effects
of marketing actions (JMP Pro), and multiple factor analysis.



Analyze Menu (Continued)

Item

Genetics

Graph Menu

Item

Graph Builder

Bubble Plot

Scatterplot Matrix

Parallel Plot

Cell Plot

Scatterplot 3D

Contour Plot
Ternary Plot
Surface Plot

Profiler

Description

Marker Statistics platform provides a convenient method for exploring several properties of
all the biallelic markers in a data set, for the purpose of quality control (QC) and possibly
selecting markers to be removed from the analysis.

Marker Simulation platform is used to evaluate potential crosses using information from
parental genetic markers and predictor formulas for traits of interest to breeders. It generates
output of the simulated marker genotypes for all progenies with their respective predicted
trait values across generations. It also provides summary statistics for the predicted trait
values for each cross across generations.

Description

Provides an interactive interface to create flexible trellis displays that are useful for visualizing
multivariate data. Plots can be conditioned on discrete and continuous variables and include
dot plots, smooth curves, normal density ellipses, box plots, lines, bar charts, and histograms.
Available plots include contour plots, maps, parallel plots, mosaic plots, pie charts, treemaps,
area charts, heat maps, formula charts, and line of fit. Map shapes are also supported.

Displays circles according to positional specification. Circles can be sized and colored according
to selected variables. When there is a time variable, selected variables can be viewed
dynamically over time.

Displays scatterplots and density ellipses for all pairs of Y variables, or for a selection of Y
variables plotted against one or more X variables.

Draws a plot that connects the values of selected Y variables for each row in the data table.

Creates a rectangular array of cells drawn with a one-to-one correspondence to data table
values, and colored by the values in the cells.

Creates three-dimensional rotatable plots for multiple Y variables. Displays and saves principal
components, standardized principal components, and rotated components. Also displays
normal contour ellipsoids, nonparametric density contours, and biplot rays.

Constructs contour plots for one or more numeric response variables, Y, across a grid defined by
two numeric X variables.

[lustrates the distribution of three-part (numeric) compositional data, using a two-dimensional
plot.

Creates a three-dimensional, rotatable display of points or of a surface defined by a saved
formula.

Displays prediction traces for each X variable, based on saved prediction formulas for each
numeric response and linear constraints on the X variables. Allows simultaneous optimization
of responses using desirability functions, estimation of response distributions using the
simulator, and accesses and links to other profilers. Can be saved as an Adobe Flash file (.swf) to
display in a web browser.
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Graph Menu (Continued)

Item

Contour Profiler

Mixture Profiler

Custom Profiler

Legacy

Tools Menu

Item

Arrow

Help

Selection

Scroller

Grabber

Brush

Description

Displays contours of the prediction formulas for two factors at a time, along with
three-dimensional mesh plots. Accesses the simulator, and links to other profilers.

Displays a ternary plot and contours of the prediction formula for models involving mixture
factors. Accesses the simulator, and links to other profilers.

Provides an interface for simultaneous optimization of responses, similar in function to the
profiler. Allows linear constraints and a user-defined criterion for optimization, and displays
predicted performance relative to benchmarks. Accesses the simulator, and links to other
profilers.

Provides access to graphs that you can now create in Graph Builder.

e Treemap creates a rectangular tiling for a nominal or ordinal variable where you can tile
categories to be proportional in size to the counts of categories within a selected variable. A
positional specification is optional.

e Chart plots bar, line, pie, needle, and point charts of user-specified summary statistics for
multiple selected Ys across the values of up to two X variables.

* Overlay Plot plots one or more numeric Y variables across the values of a single X variable;
several plots are constructed in one window using grouping variables.

Description

The default tool.

* Enables you to select points in plots and analysis options. Drag the cursor to select multiple
points.

* Rotates the plot in Surface Plot and Scatterplot 3D.
Opens context-sensitive Help when you click the help tool in any part of a display or report.

Enables you to select rows or regions of rows when you click and drag. Selects portions of
graphical output or analysis results.

Scrolls a report or journal window in any direction with more precision than when using scroll
bars. The scroller is available in report windows and journal windows.

* Changes axis scaling when you hover with grabber and click over an axis. Hand changes
orientation to indicate direction of change.
* Changes both axes simultaneously when you click and drag within a plot.

¢ In histograms, changes the number of bars or shifts the boundaries of the bars on the axis
when you click and drag.

¢ Inany report table, rearranges columns.

* In Surface Plot and Scatterplot 3D, click and drag an axis to move it. When you click the plot,
the grabber turns to an arrow and enables you to rotate the plot.

Enables you to select one or more points when you brush over them.
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Tools Menu (Continued)

Item
Lasso

Magnifier

Crosshairs

Ruler
Annotate

Line, Polygon, and
Simple Shape

Description
Enables you to circle points with a curve. Press Shift and circle more points to extend a selection.

Enables you to zoom in to a plot when you click where the enlarged graph should be centered.
Double-click to restore the graph to its original dimensions.

Displays a moveable set of magnified axes to precisely locate points and estimate distances on
plots.

Enables you to drag a ruler on a graph to measure distances.
Enables you to add editable text notes to JMP reports and journals.

Enables you to draw lines, polygons, and shapes on JMP reports and journals. Press Ctrl and
click a line or shape for a menu of options.

The Project menu appears only when a project is open.

Project Menu

Item

Undo Layout
Redo Layout
Reset Layout

Show Workspace

Show Bookmarks

Show Contents

Show Recent Files
Show Log

Project Settings

View Menu

Iltem

New Data View
Redraw Window
Show Properties

Make Text Bigger

Description

Enables you to undo actions performed on the tabs.
Enables you to reverse actions performed on the tabs.
Returns all open reports and data tables to a tabbed view.

Opens or closes the Workspace pane in the project window. This pane shows tables, reports, and
scripts that are open in the project.

Opens or closes the Bookmarks pane in the project window. This pane shows shortcuts to
frequently used files and folders, organized into groups.

Opens or closes the Contents pane in the project window. This pane enables you to view, open,
and modify files in the project contents.

Shows a list of recently used files, the same files shown on the Home Window.
Opens or closes the Log in the project window.

Enables you to write a script to automate tasks when the project is opened.

Description

Displays a duplicate view of the active data table that is linked to the original data table.
Refreshes a window after it shows stray imperfections from high-speed, dynamic handling.
Enables you to modify the formatting of display boxes in a report.

Increases the size of text in all open windows.
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View Menu (Continued)

Item

Make Text Smaller
Show Toolbar
Hide Toolbar

Customize Toolbar

Customize Menus
Running Queries

Add-Ins...

Window Menu

Item

Minimize

Zoom

Move Window to
Left Side of Screen

Move Window to
Right Side of Screen

Revert

Hide

Hidden

Set Report Title
JMP Starter
Log

JMP Home

Show Data Table

Description

Decreases the size of text in all open windows.

Shows toolbars. (Available only when toolbars are hidden.)
Hides toolbars. (Available only when toolbars are shown.)

Enables you to drag new toolbars, platform icons, and miscellaneous icons to the toolbar and
change their display size. Also enables you to display these items as icons, text, or both and revert
to the original toolbars.

Displays the JMP Menu Editor for customizing menu items.
Enables you to view ODBC queries that are running against an SQL database.

Lists the add-ins that you installed in JMP.

Description

Minimizes the active window. Press Option and select Minimize All to minimize all open JMP
windows.

Optimally sizes a window for your display. Press Option and select Zoom All to resize all open
JMP windows.

Moves the active JMP window to the left side of the screen. This command is available before you
select either of the Move Window commands or after you select Move Window to Right Side of
Screen.

Moves the active JMP window to the right side of the screen. This command is available before
you select either of the Move Window commands or after you select Move Window to Left Side of
Screen.

Appears after you select Move Window to Left Side of Screen or Move Window to Right Side of
Screen.

Suppresses the display of the active window but does not close the window.

Enables you to select the hidden windows that you want to view.

Enables you to rename the active report.

Opens or brings the JMP Starter window to the front.

Opens a window that shows information such as JSL statements as they execute and script errors.

Opens or brings to front a window that lists recently opened JMP files. Shows open JMP windows
in an outline view (the same list that appears when you select File > Open Recent).

Brings the data table for the open report to the front.

13



Window Menu (Continued)

Item

Combine
Windows...

Move to/from
Project...

Bring All To Front

Recall Last Platform

Help Menu

Item
Search
JMP Help
Search JMP

JMP
Documentation
Library

Discovering JMP
New Features

Quick Reference
Card

Menu Card

Sample Data Folder
JMP on the Web

Tutorials
Tip of the Day

Statistics Index

Scripting Index

Description

Enables you to select open JMP windows and merge them into a dashboard. Options include
using a report as a selection data filter and displaying in Full or Summary view.

Enables you to move selected windows to or from a new or open project.

Brings all JMP windows to the front. Press Option and select Arrange in Front to display the
windows one in front of another.

Opens the platform launch window that was last opened.

Description

Enables you to search for and open JMP menu items.
Opens the latest JMP Help in a web browser.

Search JMP to find statistical tests and other capabilities.

Opens a single, searchable PDF file that contains all JMP books.

Opens a PDF file that will help you get started with JMP.
Opens a PDF file where you can learn about the latest features in JMP.

Opens a PDF file that contains keyboard shortcuts to help you work faster.

Opens a PDF file that contains descriptions of JMP menu options.

Opens a list of JMP sample data to learn about JMP analyses. Open a sample data file and run a
script to see a sample analysis.

Opens the JMP website, JMP New User Welcome Kit, JMP User Community, Statistical Thinking
Course, and Statistics Knowledge Portal.

Opens a set of JMP tutorials to learn about statistical techniques.
Opens the Tip of the Day window, which provides tips and tricks for using JMP effectively.

Defines statistical terms, opens online Help, launches analysis platforms, and enables you to run
scripts that illustrate the terms.

Defines JSL functions, JSL objects, and display box elements. Several search options are available.
You can also run examples and read online Help for the components. Above the list of commands,
select All Categories to search all functions, objects, and display box elements.
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Help Menu (Continued)

ltem Description

Sample Index Opens the Sample Index window, which provides links to sample files. Many sample data tables
include scripts that you can run to see examples of JMP tools and analyses. You can also run the
sample scripts themselves to see examples of JMP tools and analyses.

Renew License Enables you to select a new license file to renew your JMP license. Available only in annual license
copies during the grace period and before the license expires.

The Format menu appears only when an application or dashboard is open.

Format Menu

ltem Description

Add Module Creates a new empty module.

Delete Module Removes the currently displayed module from the application or dashboard.

Align Boxes Lines up the selected objects by the type of alignment that you select from the submenu.
Add Container Places the selected object inside the object that you select from the submenu.

Remove Container = Removes the selected object from its container.

JMP and all other JMP Statistical Discovery LLC product or service names are registered trademarks or trademarks of JMP Statistical Discovery LLC in the USA and other countries,
® indicates USA registration. Other brand and product names are trademarks of their respective companies.
Copyright © 2022-2023 JMP Statistical Discovery LLC. All rights reserved.
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